CSE 331
Software Design & Implementation

Autumn 2022
Section 2 — Development Tools
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Administrivia

« HW1 due yesterday
« HW2 due Wednesday, 10/12, at 11PM

« Come to office hours!
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HW2 Overview

« HW2 has a few different pieces—make sure to do them all!

» Written portion (submit on Gradescope)
* Reasoning with loops

« Coding portion (submit with Gitlab tag)
« Setting up repo, simple Java code
« Looking at JUnit tests
« Debugging code
* Implementing code based on an invariant
The written portion can be done before you setup the software.
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Course resources

e We can't cover everything in an hour

e Read documentation: cs.uw.edu/331 > “Resources” tab
— “Project Software Setup”
— “Editing, Compiling, Running, and Testing Java Programs”
— “Version Control (Git) Reference”
— “Assignment Submission”

e The resources page is a treasure trove of helpful information!

UW CSE 331 Autumn 2022


https://cs.uw.edu/331/
https://cs.uw.edu/331/tools/software-setup.html
https://cs.uw.edu/331/tools/editing-compiling.html
https://cs.uw.edu/331/tools/version-control.html
https://cs.uw.edu/331/tools/turnin.html

Software You Need

e Java 11
— adoptium.net/temurin/archive

— Choose “OpenJDK 11” and install jdk-11.0.14.1+1 with the JDK
installer for your OS

— Windows: Select "Add to PATH” and “Fix Registry” during install
o IntelliJ
— jetbrains.com/idea
— Recommended: Ultimate version
e Comes in handy later in the course
e Free for students, see course website for link to license
— Install the latest version
o Git
— git-scm.com

— (Might be slightly newer version than the XCode command line tools on
macOS if you have those installed)

— Comes with Git Bash on Windows — important! 5
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https://adoptium.net/temurin/archive/
https://www.jetbrains.com/idea/
https://git-scm.com/downloads

Warning: You must use JDK 11+

e Must use JDK version 11 or later
— Be sure that's what you have installed!
— You can use a later version, but it must work on JDK 11
— Download links in Resources webpage
— Use the Adoptium installers (only)

e An out-of-date JDK can lead to very confusing bugs
— No fun for either of us!
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IntelliJ

e The officially supported IDE/editor for this course
— Full setup instructions in “Project Software Setup” handout

e A modern IDE, commonly used in industry
— Get the “Ultimate” version — free license for education use

e |IDE = “Integrated Development Environment”
— Auto completion
— Version-control (git) integration
— Debugger integration
— ...and an assortment of other fun features

e Necessary functionality covered in course documentation
— “Editing, Compiling, Running, and Testing Java Programs”
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Version control

e Also called source control, revision control

e System to track changes in a project codebase
— Unit of change ~ lines inserted/deleted across some files
o
e Essential for managing software projects 0 glt
— Maintain a history of code changes
— Revert to an older project state
— Merge changes from multiple sources v G I tLa b

e WEe'll use git and GitLab in this course, but alternatives exist

— Subversion, Mercurial, CVS
— Email, dropbox, thumbdrives (don’t even think of doing this!)
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Version control concepts

e Arepository (“repo”) stores a project’s entire codebase

— Stored in multiple places and synchronized over the internet
— Tracks the files themselves and changes to them over time

e Each developer clones her own working copy of the repo
— Makes a local copy of the codebase, on her laptop/computer
— She modifies these files directly, with her IDE or text editor

e Each developer commits changes to her working copy
— Saves “a commit” to version control history
— Affects only the local working copy
— Must synchronize with remote repo to share commits each way
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Essential git concepts

e commit
— Saves (a subset of) the changes to the local

[
i
} il ::
:1' L)

repository
— Has a brief message summarizing changes o
)
e push i %
— Sends local commits to the repository (on GitLab) gf\/fﬂ\)
— Allows other computers to then “pull” those t\it/)/g
commits/changes, see below. =
v g
e pull Working
— Synchronizes working copy to match the remote =
repository

— clone = the first pull, also sets up the repository for
the first time
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Diagram of git usage
Starter Code
Working push g ' push
Copy pull pull
— ﬁ

HW Solutions
1commit commit1

Course Staff Student

‘remote”
Backs Up Code
Sharing Between Computers

Grading Working on
New Assignments Assignments
Staff Tests
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Your GitLab repository

e WEe'll push starter code to your repo for each homework
— After HWZ2, you'll get it by pulling

e Commit and push your code as you do the assignment
— Recommended process: edit, test, pull, commit, push

e Submit homework N by creating a tag “hwN-£final”

— Check that you’ve committed and pushed all your work before you
tag!

— Do not attach a message with the tag

— Example: “hw2-£final” for HW2

e Without the right tag, your homework might not be graded!
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Example commit history
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Best practices when using git

e Pull/Commit/Push your code early and often!!
— You really, really don’t want to deal with merge conflicts
— Best to pull before you commit (in 331, industry is more complex)
— Keep your repo up-to-date as much as possible
— Copies on the server are a backup if you need to find older files

e Do not rename files and folders that we gave you
— That will mess up our grading process

— It would be a silly reason to lose points!

e Use this repo just for homework
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Gradle: what is it ml‘aC"e

Gradle is a tool for build automation
— Simplifies compiling, running, and testing a software project
— No need to install: included in the starter code!

Configured by the file build.gradle (and others) in your repo
— You shouldn’t modify this (can interfere with grading)!
— Ask the course staff for help if it got messed up accidentally.

Intellid has built-in support to work with Gradle

e Gradle is how you run/validate your code on attu
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Gradle: how to use it

e You can use Gradle at the command line or in IntelliJ (recommended)
— Every homework assignment has a “name” — HW3 is “hw-setup”

Gradle o — %
S + L AR AR R z
(auto-import enabled) f—,_
poly %
] -
HW Name 2 IntelliJ
- Right
/ § .
Tasks ———— 3 Sidebar
Double-click tasks to run
them.
Make sure you're in the
right assignment’s task
list, each one has its own
tasks. IntelliJ Gradle Panel
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Let's Try It!

Get your computers out and start up
Terminal (macOS) or Git Bash (Windows)

UW CSE 331 Autumn 2022

17



Getting Connected to GitLab

Generate an RSA key pair:

ssh-keygen -o -t rsa -b 4096 -C "your(@email.com"

The (-C) comment can be any string, make it something you'll
recognize.

Press enter when asked for a file name (use default)
No passphrase

You'll be told: “Your public key has been saved in (...)"
Copy the generated public key (use the file name of the public key
from above, if different)
cat ~/.ssh/id rsa.pub | clip (Windows)
cat ~/.ssh/id rsa.pub (macOS/linux)

macOS/linux: Select and copy the output of running the cat
command
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Getting Connected to GitLab (2)

— Paste that into your GitLab account, under “Preferences” > “SSH
Key”

e Sign in at: gitlab.cs.washington.edu

— In Terminal/Git Bash, type the following to check that you’re set up:
ssh -T git@gitlab.cs.washington.edu

— Getting “The authenticity of host (...) can’t be established”?

e Type yes — only a one-time thing, the GitLab server is just
unfamiliar to your computer.

— Should get a welcome message back!
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19



Cloning Your Repo

e |n GitLab, open your project page and get the SSH clone URL
gitlab.cs.washington.edu/cse331-22sp-students/cse331-22sp-NETID

e Blue “Clone” button in top right: copy the “Clone with SSH” URL
e Open Intellid

— You don'’t need any plugins or launcher scripts, skip those steps
e Choose “Get from VCS”

e Choose 'Git', paste the clone link from earlier in '"URL', and choose a
place on your computer in 'Directory' where you want to keep your
331 work.

e C(Click Clone
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Importing Into Intellid

e Need to set up project SDK: Select Java 11
— File > Project Structure > Project

e Missing?
— Click New > JDK, IntelliJ should auto-find your Java 11 install
— Can’t find it? Check your Java installation and ask for help.

® 0 Project Structure

Project name:
cse331-19au-agies

Project Settings
Project SDK:
Modules This SDK is default for all project modules.
— A module specific SDK can be configured for each of the modules as required.
Libraries —
Facets | = 11 (java version "11.0.5") Hl New... Edit
Artifacts Project language level:
Platform Settings This language level is default for all project modules.
SDKs A module specific language level can be configured for each of the modules as required.
Global Libraries | 11 - Local variable syntax for lambda parameters ul
Project compiler output:
Problems

This path is used to store all project compilation results.

A directory corresponding to each module is created under this path.

This directory contains two subdirectories: Production and Test for production code and test sources, respectively.
A module specific compiler output path can be configured for each of the modules as required.

? Cancel Apply “
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Importing Into IntelliJ

e Also, need to check some Gradle settings
e IntelliJ IDEA > Preferences (macOS), File > Settings (Windows/linux)
e Build, Execution Deployment > Build Tools > Gradle

[ JSN ) Preferences

O

Appearance & Behavior
Keymap

Editor

Plugins

Version Control

Build, Execution, Deployment

Build Tools
Maven

Gant
BSP
sbt
Compiler
Debugger
Remote Jar Repositories
Deployment
Arquillian Containers
Android
Application Servers
Coverage
Docker
Gradle-Android Compiler
Java Profiler
Required Plugins
Languages & Frameworks
Tools
2

Build, Execution, Deployment > Build Tools > Gradle For current project

General settings

s/fandrew/.gradle

Override the default location where Gradle stores downloaded files, e.g. to tune anti-virus software on Wir

Gradle user home:

Generate *.iml files for modules imported from Gradle
Enable if you have a mixed project with IntelliJ IDEA modules and Gradle modules so that it could be shared via VCS

Gradle projects

Download external annotations for dependencies

Build and run
By default IntelliJ IDEA uses Gradle to build the project and run the tasks.
In a pure Java/Kotlin project, building and running by means of the IDE might be faster, thanks to

optimizations. Note, that the IDE doesn’t support all Gradle plugins and the project might not be built
correctly with some of them.

Build and run using:  Gradle (Default) a

Run tests using: Gradle (Default)
Gradle

. N A
Use Gradle from:  'gradle-wrapper.properties' file
Gradle JVM: < Project SDK 11 l

Cancel Apply
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Does yours look different
from this screenshot?

Make sure you are using
the latest version of
Intellid — Gradle support
has changed recently.
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Development Workflow Demo

1. Open the first part of the hw2 starter code:
— hw-setup/src/main/java/setup/HolaWorld.java
2. Fix the two bugs in this code: Lines 38 & 45
3. Run the code using Gradle:
— Open the Gradle panel on the right edge of IntelliJ
— Provided a runHolaWorld Gradle task under the “homework” group
— c¢se331 > hw-setup > Tasks > homework > runHolaWorld
4. Double-click to run the task: see the output at the bottom!
— Gradle automatically compiles your code and then runs it.
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Development Workflow Demo (2)

Let’s try using the IntelliJ Debugger to examine our code.
1. Set up a breakpoint on IiﬁnefB? py clicking in margin.

O System.ovt.println(myFirstHW.getGreeting());
System.ovt.println(world.getGreeting());

2. Run the code with “Debug”. Look at the program state:

Debug: » cse331-22sp-egreisz [HolaWorld.main()]
¢, Debugger ENcConsole = 2 + ¥ 1 Y B
A Frames Threads Variables

® “main"@1...": RUNNING  ~ Y + > 8 static members of HolaWorld

main:37, HolaWorld (setup)

»

=}

» R O problems | #Debug M Git B Terminal G profiler  i=TODO N\ Build

3. Step Over = to move to line 37. This executes the current line.

4. Step Into £ the getGreeting() method. This enters a method called on
the current line to debug. We are now in getGreeting().

5. Resume Program !> . This will run to the next breakpoint (or in our
case, until the program finishes).
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Development Workflow Demo (3)

We've finished part 4 of the assignment (!) — let's commit this code to save it.
1. “pull” to make sure we have any updates that happened while we were editing:
— Git > Pull (use the default options)
2. “commit” the changes to save them to our local copy of the repository:
— Git > Commit
— Check the boxes for the file changes you want to include in the
commit (usually all files)

— Uncheck everything under “Before Commit” (just extra Intellid warnings, you
can keep them but it adds extra steps to the commit). You may need to click
the settings wheel in the bottom right of the commit window to find the
"Before Commit" section

— Enter a short (< 25 words), helpful description of the changes in “Commit
Message”

3. "push” the changes to tell GitLab about the new commit:
— Git > Push
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Development Workflow Demo (4)

In general, only do this at the end of an assignment, but let's see how it
works with a practice tag.

1. Create the tag with the correct name. For now, use section-demo. See
assignment specs for the tags to use for each assignment.

— Git > New Tag
— Enter a tag name. (Tags are case-sensitive.)

— DO NOT include a message. (This can make the tags difficult to
move later, if you need to.)

— Tags are automatically attached to the current commit on the
remote repository (so you need to create tags after creating and
pushing the commit you want to tag in a separate transaction).

2. “push” the changes to tell GitLab about the tag (so the staff can see it!)
— Git > Push
— Make sure “Push Tags” (bottom left) is checked. (Choose “All”)
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Development Workflow Demo (5)

GitLab Runners:
— Triggered when you push the tag

e Don’t see a runner? Make sure you have the right tag name!
(Tags are case-sensitive)

— Runs some sanity checks (build, javadoc, and your tests) to look for
common errors.

— If your runner fails, you should definitely fix it, then move the tag
and check the runner again.

— Open your GitLab project online, go to CI/CD - Pipelines (found in
left hand options bar)

— For section-demo, you’ll see a message and the pipeline should
pass.

— For actual assignments, you'll see it run checks on your
assignment, then it'll either pass or fail and print an error message

on failure.
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Development Workflow Demo (6)

Verifying your tag is on the correct commit:
» GitLab Repository: Left Sidebar > Repository > Graph

This page provides a good visual
for which commit your tags are

attached to!

Also can check out Repository >Tags
(browse the files and check that the
SHA matches the one found in

Repository > Commits)

= hwo-final

-0- dc75b40e - HW9 Frontend and Backend con

O hw8-final
-0- 0c79b6ff - HWS, Edge parsing, displaying, §

= hw7-final

-0~ 7f5%acc5 - HW7, Fixed Javadoc comments -

<DRelease feedback for hwo
fi.nal DHUQ Frontend and Backend complete
DRelease feedback for huws
DRelease feedback for hw7
Dstaff push of files
DSta*F-F push of files
[ hu8-Final 2 DHUS Edge parsing, displaying, and Clear button

DHHS basic functionality of the grid component

DSta*Ff push of files

DRelease feedback for hwé

DHW, Fixed Javadoc comments
DHW, Part 4 Model Implementation
DH\J’/‘, Part 3, Dijkstra and tests
DHW, Part 1, Made the Path generic
DHU?, Part 1, Made the graph generic
DRelease feedback for hwé

|
==
1
1
1
1
1
{
l (]
1
1
1
1
1
1
1
I

Dstaff push of files
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Gradescope + Late Days

e Once we are done grading, you will find your feedback on Gradescope.

e You do not need to upload the coding portion to Gradescope—we will
do that automatically
e Ignore the submission time on Gradescope
e We will send you a confirmation email including the # of late
days this assignment used and the # of late days you have
remaining
e But you will need to upload the written portion

e To use a late day, just submit your assignment late (tag a commit within
24 hours after it's due). No need to email us or let us know.
e Realized you made a mistake? You can re-tag before the deadline!
Instructions here: Assignment Submission
e If you want to spend a late day to fix a mistake in your submission,
feel free! (Even after you receive the confirmation email.) But you

must turn it in before the late deadline.
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https://cs.uw.edu/331/tools/turnin.html

Important Handouts

https://cs.uw.edu/331/resources.html

e Project Software Setup handout
— Important settings for IntelliJ (you need to set these)

— Running your code on attu, in a virtual machine, or on remote
desktop.

e Running/Compiling/Testing/Editing
— How to use Gradle to run automated tests and see test results in
Intellid.
— [Optional] SpotBugs: A useful tool for finding bugs in your code
e Version Control handout
— Git best practices, instructions, and more advanced usage
e Assignment Submission handout
— Creating and moving tags, using late days, GitLab validation
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